
LanSafe III
Power Management Software

User Manual
Section 1. LanSafe III for Data Protection

Section 2. LanSafe III-Installation Guide

Section 3. Operation
Normal Operations (Green Icon)
Battery Operations (Yellow Icon)

Power Monitor Messages from Other Network Nodes
Emergency Operations (Red Icon)

Things to Remember about Running the Software
Things to Remember about UPSs with Dry-Contact Interfaces

Understanding UPS Groups
UPS Group Terminology
UPS Group Communications Requirement
Things to Remember About LanSafe III in a UPS Group

Communications Setup
To Change Communications Ports
To Run the Console

Monitoring a Power Environment
To Select Input and Output Phases for Viewing
To Change Console Views
To Select Another Node to Monitor (LanSafe III)

Viewing the Logs
To Access a Log
To Enable the Periodic Log
To Establish Periodic Log Settings

System Control Features
To Select a LanSafe III Node to Control
To Control a Node with Another LanSafe III Access Code
To Change the LanSafe III Access Code for a Node
To Change the LanSafe III Access Code for a Network
To Configure the Network UPS Access Code for a UPS Group

Diagnostics Tasks
To Set up a Maintenance Reminder
To Test Hardware for the Selected Node
To Test Hardware for Network (LanSafe III)
To Run Preventive Maintenance

Alert Response
To Reconfigure Shutdown Timing
Things to Remember about Shutdown Timing

Customizing Alerts
To Change the Text for a Message
To Execute a Command when an Alert Occurs
To Send E-Mail
To Send a String to a Modem
Creating a modem string
To Set a Delay Time for an Alert Message
To Send Broadcast Messages to Logged-On Users (LanSafe III)
To Send Netfinity Alerts



Routine Shutdowns
To Unload the Power Monitor (LanSafe III)
To Shut Down and Reboot the System
To Shut Down a Load Segment on a Scheduled Basis

Load Shedding
To Configure Load Segments
To Shorten a Shutdown Delay
To Delay Restart of a Load Segment
To Set a Restart Delay
To Delay Restart of Non-Essential Peripherals

Accessing the Help System
To Check the Software Version

Alternate Console Startup Methods
To Monitor LanSafe III on Another Node
To Control LanSafe III on Another Node
To Control a Node in a Group Whose Access Codes Differ from Yours
To Limit your Build to Speed Network Polling

Section 4. UNIX Text-Based Environment Operations
To Start the LanSafe III Console for Your Own Node

To Start LanSafe III and Select a Node to View or Control
Configuring LanSafe III

To Close the Screen and Return to the Main Menu
To Enter a New Communications Port
To Configure Shutdown Timing
To Schedule Maintenance
To Change the Access Code
To Save any Setting Changes You Have Made
To Cancel any Changes and Restore the Defaults
Running a Hardware Test or Preventive Maintenance
Shutting Down or Rebooting the Workstation
Monitoring a Power Environment
To Update the List, or to Close It
Exporting Log Files

Appendix A. Troubleshooting

Appendix B. Glossary



LanSafe III for Data Protection
LanSafe III is a power management, system shutdown software application for
uninterruptible power systems (UPS) supporting networked computer systems. While you
create a protected power environment when you add a UPS to your system, power
management software provides you with automatic, unattended system shutdown
capabilities and powerful monitoring, control features.

The primary goal of power management software is the protection of your computer data.
In the event of a power disturbance (utility failure, sag, surge, brownout, under voltage or
over voltage) the UPS provides clean power to the system, in place of utility power. If the
event status is not changed, this continues either until the UPS is exhausted or the power
management software conducts an automatic, orderly system shutdown as it was
programmed to do.

You can use your power management software to monitor your power environment
including the amount of available battery power and runtime, and you can use it to control
the length of the shutdown time. Other monitoring features include Customize Alerts, a
Power Log, a Battery Management Log, and a Periodic Log.

Alert response features program your software system to perform such tasks as
executing a specific command and sending email or a string to a modem if a given alert is
received. You can also change message text, for example, to another language if
necessary.

If your UPS supports load shedding, you can divide your load into segments with different
shutdown and restart sequences to extend battery runtime for your most critical devices.

System administrators dealing with large computer networks can perform LanSafe III
control functions over all systems in their networks or domains without leaving their
desks.



LanSafe III Installation Guide
Before installation, review the System Requirements.

For instructions, choose the version of LanSafe III for your platform from the list below:

LanSafe III for OS/2
LanSafe III for Windows 95/98 (Intel) (English)
LanSafe III for Windows 95/98 (Intel) (Japanese)
LanSafe III for Windows NT (Intel) (English)
LanSafe III for Windows NT (Intel) (Japanese)
LanSafe III for Windows NT (Alpha)
LanSafe III for NetWare Servers

LanSafe III for UNIX (AT&T SVR4)
LanSafe III for UNIX (Data General)
LanSafe III for UNIX (Digital UNIX)
LanSafe III for UNIX HP-UX 10 and 11
LanSafe III for UNIX (IBM RISC/AIX)
LanSafe III for UNIX (IBM PowerPC/AIX)
LanSafe III for UNIX (Interactive)
LanSafe III for UNIX (IRIX)
LanSafe III for UNIX (Linux)
LanSafe III for UNIX (SCO Open Server)
LanSafe III for UNIX (Solaris 2.x with SunOS 5.x)
LanSafe III for UNIX (UnixWare 7)

System Requirements
All systems require the following:

•  A UPS ready for RS-232 serial communication (printer mode: 2400 baud rate for
Prestige; 1200 baud for others)

•  A dedicated RS-232 serial port for the UPS

•  A second RS-232 serial port if the modem feature is used

•  The correct cable for communication between your UPS and your computer



Installing LanSafe III for OS/2
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: OS/2 v. 2.0-4.0 with at least one network protocol installed, running on
an IBM-compatible PC.

Optional Systems: IBM LANServer 3.0-4.0 (server or requester), or IBM LanManager
3.0. Same installation procedure for LanSafe III for OS/2; no additional procedures
required.

Network protocols supported: TCP/IP v.2.0 or above. In a UPS Group, the UPS Group
Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

SNMP Agent: When computer is configured to support SNMP, installation of the
LanSafe III SNMP proxy agent is automatic.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III for
OS/2 and use the Configure Alerts dialog box to send Netfinity alerts to your system.

To Install LanSafe III for OS/2

1. Insert the compact disk into your computer’s CD-ROM drive.

2. Run <CD drive letter>:\Lansafe\Os2\Install.exe.

3. Follow the installation instructions.

After installation, start the Power Monitor and Console and test the hardware and
software.

See also:

Manual Start and Shut Down

UPS Groups



Installing LanSafe III for Windows NT (Alpha)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Windows NT v.3.5x-4.0, with at least one network protocol installed,
running on a PC with Alpha processor. Administrator privileges.

Network protocols supported: NetBEUI, TCP/IP for NT 3.51 or above. In a UPS Group,
the UPS Group Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III and
use the Configure Alerts dialog box to send Netfinity alerts to your system.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for Windows NT (Alpha)

1. Insert the compact disk into your computer’s CD-ROM drive.

2. Run <CD drive letter>:\Lansafe\Ntalpha\Setup.exe.

3. Follow the installation instructions.

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Manual Start and Shut Down

UPS Groups



Installing LanSafe III for Windows 95/98 (Intel) (English)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Windows 95 or Windows 98, with at least one network protocol
installed, running on a 386, 486 or Pentium PC.

Network protocols supported: NetBEUI, TCP/IP. In a UPS Group, the UPS Group
Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

SNMP Agent Support: When computer is configured to support SNMP, installation of
LanSafe III SNMP proxy agent is automatic.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III and
use the Configure Alerts dialog box to send Netfinity alerts to your system.

To Install LanSafe III for Windows 95/98 (Intel) (English)

1. Insert the compact disk into your computer’s CD-ROM drive.

2. Run <CD drive letter>:\Lansafe\Ntand95\Setup.exe.

3. Follow the installation instructions.

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

USB Drivers

SurfSafe

Manual Start and Shut Down

UPS Groups



Installing LanSafe III for Windows 95/98 (Intel) (Japanese)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Windows 95 or Windows 98, with at least one network protocol
installed, running on a 386, 486 or Pentium PC.

Network protocols supported: NetBEUI, TCP/IP. In a UPS Group, the UPS Group
Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III and
use the Configure Alerts dialog box to send Netfinity alerts to your system.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for Windows 95/98 (Intel) (Japanese)

1. Insert the compact disk into your computer’s CD-ROM drive.

2. Run <CD drive letter>:\Lansafe\Ntand95j\Setup.exe.

3. Follow the installation instructions.

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

USB Drivers

SurfSafe

Manual Start and Shut Down

UPS Groups



Installing LanSafe III for Windows NT (Intel) (English)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Windows NT v.3.5x-4.0, with at least one network protocol installed,
running on a 486 or Pentium PC with network services installed. Administrator privileges.

Network protocols supported: NetBEUI, TCP/IP for NT 3.51 or above. In a UPS Group,
the UPS Group Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III and
use the Configure Alerts dialog box to send Netfinity alerts to your system.

SNMP Agent: When computer is configured to support SNMP, support of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for Windows NT (Intel) (English)

1. Insert the compact disk into your computer’s CD-ROM drive.

2. Run <CD drive letter>:\Lansafe\Ntand95\Setup.exe.

3. Follow the installation instructions.

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Manual Start and Shut Down

SurfSafe

UPS Groups



Installing LanSafe III for Windows NT (Intel) (Japanese)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Windows NT v.3.5x-4.0, with at least one network protocol installed,
with Japanese language support, running on a 486 or Pentium PC with network services
installed. Administrator privileges.

Network protocols supported: NetBEUI for NT 3.51 or above, TCP/IP. In a UPS Group,
the UPS Group Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III and
use the Configure Alerts dialog box to send Netfinity alerts to your system.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for Windows NT (Intel) (Japanese)

1. Insert the compact disk into your computer’s CD-ROM drive.

2. Run <CD drive letter>:\Lansafe\Ntand95j\Setup.exe.

3. Follow the installation instructions.

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Manual Start and Shut Down

SurfSafe

UPS Groups

See also:

Manual Start and Shut Down

UPS Groups



Installing LanSafe III for NetWare Servers
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: NetWare 4.11 or 5.0, with at least one network protocol installed,
running on a 386, 486, or Pentium PC. Administrator privileges.

Network protocols supported: TCP/IP on NetWare 4.11 and above. In a UPS Group,
the UPS Group Controller and all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

IBM Netfinity Support: If IBM Netfinity is installed and running, install LanSafe III and
use the Configure Alerts dialog box to send Netfinity alerts to your system.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for NetWare Servers

1. Insert the compact disk into your computer’s CD-ROM drive.

2. From the Console, run <CD drive letter>:\Lansafe\Netware\Ls3setup.nlm.

3. Follow the installation instructions.

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Manual Start and Shut Down

UPS Groups



Installing LanSafe III for UNIX (IBM AIX/RISC)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: IBM AIX 4.3x (RISC) running on an IBM RS/6000 Series. Character-
based UI or AIX-Windows.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty0 or /dev/tty1.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount, or use the following as a guide:

mount -v cdrfs -r /dev/cd0 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (IBM AIX/PowerPC)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: IBM AIX 4.x running on an IBM PowerPC. Character-based UI or AIX-
Windows.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty0 or /dev/tty1.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -v cdrfs -r /dev/cd0 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (Digital UNIX)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Digital UNIX 4.x running on a system. Character-based UI or CDE.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty00 or /dev/tty01

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). Use mount -r -t cdfs /dev/rz4c /cdrom as a guide, or see man
page of mount.

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (Data General)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: DG-UX R4.2MU01 or higher (Intel) . Character-based UI or GUI-X
Window v.11R4 or higher.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty00, /dev/tty01, or /dev/tty02

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -t cdrom /dev/pdsk/3 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (HP-UX 10 and 11)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: HP-UX 10.x-10.20 or 11.00 running on an HP9000/xxx Series.
Character-based UI or Vue.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty00 or /dev/tty01

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

If you run the SNMP Agent, you must install HP Extensible SNMP Agent v.4 or above.

If you install an HP-UX Model 800, you need a gender bender, a null modem adapter, the
supplied cable, and a 9-25 adapter.

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -F cdfs -o ro /dev/dsk/c0t2d0 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (Interactive)
NOTE: UNIX Interactive systems support LanSafe III v. 3.72.

Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

All UNIX systems must have 3 to 5 MB of available disk space.

Required System: Interactive UNIX 3.0.1-3.2.2. Character-based UI or Looking Glass.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty00 or /dev/tty01 (serial port UPS),
or /dev/ups0 or /dev/ups1 (dry-contact UPS)

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -r -f cdfs /dev/cd0/cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Installing systems with dry-contact UPSs

Manual Start

UPS Groups



Installing LanSafe III for UNIX (IRIX)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

1. Insert the compact disk into your computer's CD-ROM drive.

2. Type sh install.sh to run the installation software.

After installation, start the Power Monitor and Console and test the hardware and
software. See Testing the Software on page 16.

Required System: IRIX v. 6.5.10. Character-based UI or GUI-X Window.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and all
UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional) - If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.



Installing LanSafe III for UNIX (Linux)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Linux with kernel 2.x.x. Character-based UI or GUI-X Window.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/cua0 or /dev/cua1

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use the following as a guide:

mount -r -o check=r /dev/cdrom /cdrom

3. Type sh install.sh to run the installation software.

After installation, start the Power Monitor and Console and test the hardware and
software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (SCO Open Server)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: SCO OpenServer 5.x. Character-based UI or GUI-X Window v.11R4
or higher.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/ttty1a or /dev/tty2a (serial port
UPS), or /dev/ups0 or /dev/ups1 (dry-contact UPS)

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -r -f HS /dev/cd0/cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Installing systems with dry-contact UPSs

Manual Start

UPS Groups



Installing LanSafe III for UNIX (Solaris)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: Solaris 2.x with SunOS 5.x and OpenWindows 3.x

Note: LanSafe III for UNIX supports the Intel processor running Solaris 2.6.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/ttya or /dev/ttyb

SNMP Agent (SPARC platforms only): When computer is configured to support SNMP,
installation of LanSafe III SNMP proxy agent is automatic.

For the LanSafe III SNMP Agent in a Solaris 2.x system, the HP Extensible SNMP Agent
v.4 is required.

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). The Volume Manager daemon vold (e.g., /cdrom/lansafe400)
mounts the CD-ROM automatically if it is running. See man page of mount or use the
following as examples:

For Solaris 2.x: mount -F hsfs /dev/dsk/c0t6d0s0 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (AT&T SVR4)
NOTE: The current version of LanSafe III for UNIX for AT&T SVR4 is v. 4.0.

Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: AT&T UNIX System V Release 4.0 Version 3.0 running on a 386, 486,
or Pentium PC.

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/term/00 or /dev/term/01

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -F cdfs -o ro,nmconv=c,fperm=0500 /dev/cd0 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Manual Start

UPS Groups



Installing LanSafe III for UNIX (UnixWare 7)
Before installing, start your UPS and connect the communications cable from the UPS to
your computer. The communications cable was supplied with the UPS.

Required System: UnixWare 7.x. Character-based UI or Destiny

All UNIX systems must have 3 to 5 MB of available disk space.

Network protocol supported: TCP/IP. In a UPS Group, the UPS Group Controller and
all UPS Group Members must use a common protocol.

In a network system, you must install at least one network protocol.

UPS Group Installations (optional): If installing a UPS Group, connect the
communications cable provided with the UPS between the UPS Group Controller and the
UPS. Connect the UPS Group Member computer power cords to the UPS.

Communication Port (enter when prompted): /dev/tty00 or /dev/tty01 (serial port
UPSs). Dry-contact UPSs not supported.

SNMP Agent: When computer is configured to support SNMP, installation of LanSafe III
SNMP proxy agent is automatic.

To Install LanSafe III for UNIX

1. Insert the compact disk into your computer’s CD-ROM drive.

2. As root, mount the CD-ROM at the mount point /cdrom, setting the options for read
only, file names are not converted, and default file permission 0500 (execute
permission to owner). See man page of mount or use as a guide:

mount -F cdfs -r -o nmconv=r /dev/cdrom/c0b0t2l0 /cdrom

3. Type ./install.sh to run the installation software (case depends on your UNIX system).

After installation, LanSafe III starts automatically. Start the Power Monitor and Console
and test the hardware and software.

See also:

Removing LanSafe III for UNIX

Installing systems with dry-contact UPSs

Manual Start

UPS Groups



SurfSafe
System administrators can now monitor the power running their networks through the
World Wide Web with SurfSafe. It is available for workstations and servers running
OnliNet or LanSafe III on Windows 95 or Windows NT systems. Server components
include a web page, java applet, and the SurfSafe server. For more details, including
installation instructions, see Readme.txt in the SurfSafe directory on the CD, or visit
www.powerware.com.

Installing LanSafe III for SCO, Interactive, or UnixWare with Dry-Contact
UPSs

1. Back up your files before you install.

2. Be sure that other users are not logged on to the system through remote terminals.

3. Never interrupt an installation.

4. Do not run background processes during installation if a system reboot could
adversely affect these processes, or if the processes would use free disk space
during a reconfiguration.

5. Read "Install the Device Driver Prompt" below.

6. Install LanSafe III.

Install the Device Driver Prompt

If you install LanSafe III in a SCO, Interactive, or UnixWare system using a UPS with a
dry contact interface, an “Install the device driver” prompt appears after the end of regular
installation. Choose y to rebuild the kernel or n to exit.

If you choose y, the kernel is rebuilt, completing installation and configuration of LanSafe
III. If you choose n, the system reminds you that you must install the device driver later.

The Relay Contact UPS driver shares I/O addresses with the system serial device driver
(asy, sio, or asyc). The device install fails if the system serial device is not configured to
share its I/O address. If this happens, either modify the system file for the serial device so
that the port the UPS uses is disabled, or modify the master file so the default serial
device can share I/O devices. Check your system documentation for information about
disabling the pre-installed serial device.

When the kernel is rebuilt, the /dev/ups0 and /dev/ups1 device drivers become available.
Use these device drivers and not the standard UNIX device drivers (/dev/tty1 and
/dev/tty2) to communicate with the UPS.

Testing the Software
1. Turn off the power to the power supply. If the hardware is connected to a power strip,

turn off the power at this source.

2. Verify that a power loss message displays on the message device you specified
during configuration.

3. Turn on the power supply source. When “Power is restored” displays, test is
complete.

Removing LanSafe III for UNIX
1. Log in as root.

2. Shut down any LanSafe III processes.

3. Type the following (assuming default installation directory)



rm -rf /usr/ls3

... where /usr/ls3 is the default directory.

Starting the Power Monitor
If you chose the autoload on startup option when you installed your power management
software, restart your computer to start the software.

For a manual start of the software, run ls3.exe for all systems except UNIX.

Manual Start, UNIX

Start the system components as follows:

Daemon
For X Windows type /usr/ls3/ls3&
For other environments type /usr/ls3/ls3&

Power Monitor Window
For X Windows type /usr/ls3/ls3X&
For other environments not available

Console
For X Windows type /usr/ls3/ls3conX&
For other environments type: /usr/ls3/ls3con

SNMP Agent
For X Windows: Not Available
For other environments type: /usr/ls3/ls3agent&

Manual Start and Shutdown, OS/2

To start, run LS3.exe

To shut down, from the Power Monitor click the Close button on the Title Bar.

Manual Start and Shutdown, NetWare

To start, at the file server type Load LS3.

To shut down, at the file server type Unload LS3.

Manual Start and Shutdown, Windows 95/98

To start, click Start, open the Programs folder, and choose Power Monitor from the
LanSafe III program folder).

To shut down, from the Power Monitor click the Close button on the Title Bar.

Manual Start and Shutdown, Windows NT

To start

1. Start the system service. Open the Services dialog box in the Control Panel and
start LanSafe III System Service System Service. The Power Monitor window opens
automatically.

To shut down

Do one of the following:

1. Stop the system service.

2. From the Console Shutdown menu, choose Unload Power Monitor.

USB Converter and Software Installation



IMPORTANT: Support of USB hardware is limited to with Windows 98 and certain UPS
models. To determine whether your UPS supports USB hardware, see your user manual.

1. Place your LanSafe III installation CD in your computer’s CD-ROM .

2. Install the USB interface unit, connecting the serial cable to your UPS
communications port, and the USB cable to the rear of your computer or USB hub.

If your computer is running (or the next time you start it), the system detects the new
hardware and the Add New Hardware Wizard opens.

3. Click Next.

The Add New Hardware Wizard says: "What do you want Windows to do?"

4. Select the "Search for the best driver for your device" radio button, and click Next.

The Add New Hardware Wizard says: "Windows will search for new drivers in its
driver database"

5. Select "Specify a location" and Click "Browse."

6. Navigate to the CD directory for the LanSafeIII version to be installed:
Lansafe\Ntand95 for LanSafe III for Windows 98 (English)
Lansafe\Ntand95J for LanSafe III for Windows 98 (Japanese)

7. Click OK and Next.

The Add New Hardware Wizard says: "Windows driver file search for the device:"

8. Click Next.

9. Click Finish.

Setup screen for LanSafe III opens.

10. Install as prompted.



Operation
For your uninterruptible power system (UPS) hardware and power management software
to work together, they must communicate. When you start your power management
software, or when it starts automatically when your system is booted, you start the Power
Monitor (also known as the Power Monitor daemon in LanSafe III for UNIX and the
LanSafe III system service in Windows NT).

Running in the background, the Power Monitor (or daemon or system service)
communicates with the UPS and provides information and services to the Console. The
Power Monitor also provides alert processing, orderly shutdown, and log functions. The
Console program is the primary user interface for system control, diagnostics, managing
alert response, and shutting down the system.

Communications require the use of the correct communications cable (the cable
furnished with the LanSafe III software). The software must be configured to reflect the
computer communications port used for the cable. If your UPS supports load segments,
you can configure the load segments in the software, too.

Normal Operations (Green Icon)

When LanSafe III receives a command to start, the Power Monitor attempts to establish
communications with the UPS. If successful, the Power Log records the date, time and a
“Communications established with UPS” message. The Power Monitor status window, if
opened, displays the most recent events from the Power Log.

If the Power Monitor cannot establish UPS communications, the result is a
“Communications failure with UPS” log entry. Until the communications setup is
corrected, the Power Monitor icon and Power Monitor status window display of the
message are yellow; the Console displays a yellow Input/Output Failure message. See
the Troubleshooting Guide, Appendix A.

If the operations situation is normal, the Power Monitor icon is green. Power Log
messages displayed on the Power Monitor status window are green.

Battery Operations (Yellow Icon)

If a power problem occurs, the UPS batteries provide system power until exhausted or
until expiration of the shutdown time you enter. The Power Monitor icon turns yellow. The
system shuts down either when battery power is gone, or in accordance with your
shutdown configuration.

Save your work and close your files immediately, then try to analyze and resolve the
problem. If the situation persists, contact your utility.

Power Monitor Messages from Other Network Nodes

Whenever a change in power status occurs, LanSafe III can generate Power Monitor
messages to network users with Windows, OS/2, and UNIX systems. To modify the list of
users to receive broadcast messages from your system, choose Customize Alerts from
the Setup menu.

Receipt of broadcast messages varies with your system, as follows:

•  In OS/2 and UNIX, receipt of messages is automatic.

•  In Windows 95, you must start WinPopup.

•  In Windows NT, v. 4, you must either start WinPopup (NT 4.0 or higher only) or run
the Alerter and the Messenger services.



Emergency Operations (Red Icon)

When a shutdown is about to occur, the Power Monitor icon and Power Monitor Status
messages related to the shutdown turn red. When power is restored, the icon and
messages return to green.

Things to Remember About Running the Software

•  For full functioning of LanSafe III software, a UPS must support the node.

•  Power monitoring occurs only after you start the Power Monitor within the appropriate
operating system or environment.

•  If a system shutdown is necessary, the software saves only named files. To avoid
loss if a power failure occurs, name any new files as soon as you open them.

•  For applications with automatic saving capability, set the autosave time to a value
less than the power failure countdown time.

•  To reconfigure the software, it is not necessary to reinstall or reload. New
configuration settings become active when you close the dialog box.

•  Control is limited to the computer on which you run the Console and LanSafe III
remote nodes for which you enter the access code.

•  Never try to run more than one copy of the software at once.

Things to Remember About UPSs with Dry-Contact Interfaces

•  UPSs with dry-contact interfaces support only limited Console information.

•  UPSs with dry-contact interfaces do not support hardware tests and preventive
maintenance.

•  UPSs with dry-contact interfaces do not support the Battery Management Log.



Understanding UPS Groups
There are differences, albeit small ones, in the installation and operation of Power
management software when your UPS supports one computer and when it supports two
or more computers. If the computers in your system each have their own UPSs, you need
not be concerned with this section.

Installation of a LanSafe III Group Controller is not recommended on a Windows 95/98
system due to the operating system’s way of handling multitasking. Other operating
systems that handle multitasking in a more sophisticated and prioritized manner, such as
Unix and Windows NT (with Service Pack 3), are recommended for use as the LanSafe
III Group Controller.

UPS Group Terminology

When more than one computer is plugged into a single UPS, the supported computers
are called a UPS group.

Only one computer in a UPS group can be attached to the UPS by means of a serial
communications cable. This computer is known as the UPS group controller. Any
computer in the UPS group that is not the UPS group controller is known as a UPS group
member.

UPS Group Communications Requirement

LanSafe III communications require that the UPS group controller be running whenever
any group member is running. Otherwise, the LanSafe III UPS monitoring module, which
runs on each group member, cannot obtain UPS status and alert information from the
group controller. This means that UPS group members are not notified of power failures
and do not perform an orderly shutdown.

Things to Remember About LanSafe III in a UPS Group

•  LanSafe III communications require that the UPS group controller run whenever any
group member runs.

•  The shutdown time for the UPS group controller must be longer than the shutdown
time for any group member.

•  Any group member can run a LanSafe III Console to control and configure LanSafe III
for all units within the UPS group.

Communications Setup
When you install the software, you designate the computer communications port you use
to join the communications cable to the UPS. If you change communications ports on the
computer, you must reconfigure the software.

To Change Communications Ports

1 Choose Communications Port from the Setup menu to open the Communications Port Setup dialog box.
2 Complete the steps for All Users Except Novell File Servers or Novell File Servers.

All Users Except Novell File Servers

1. Choose either Standard or Custom.
If you choose Standard, a list of communications ports becomes active. If you choose Custom, an edit field
becomes active.

2. If you selected Standard, highlight the port your computer uses for serial
communications with the UPS. If you selected Custom, enter the device name. See
your communications port manufacturer’s hardware manual for information.

Novell File Servers



1. Choose either COM1 IRQ4 Addr=03F8, COM2 IRQ3 Addr=02F8, or Custom.

2. If you selected COM1 IRQ4 Addr=03F8 or COM2 IRQ3 Addr=02F8, choose OK to
close the dialog box.

3. If you selected Custom, the IRQ field and Addr edit field become active and require
you to make entries. See your communications port manufacturer’s hardware manual
for information.

To Run the Console

Do one of the following:

•  Choose Run Console from the Power Monitor menu bar.

•  In OS/2, double-click the Console icon in the program folder.

•  In the directory where your power management files are stored, start LS3CON.exe.

Monitoring a Power Environment
Using the PowerScope or Data view of your Console, you can monitor the power
environment of your local node. In LanSafe III, you can monitor any node in your network.
If your utility power is 3-phase, you can view by input and output phase. Monitoring
includes the ability to review logs.

Data view and PowerScope share the same sections for node information and
communications status.

NOTE
PowerScope view and Data view are limited on UPSs with dry contact interfaces

Node/System Information section. Node information includes the software type and
version, the node type and address, and the UPS model name, numbers and revision.

Communications status section. Communications status is a text message describing
the state of current communications.

The PowerScope diagram reads from left to right. It includes values for input voltage,
output voltage, available run time, the current battery or ABM status, and the current load
%.

Volts In. The Volts In section on the left side of the screen shows the voltage of utility
power and a colored bar. The color describes the power situation, either as acceptable
(green), near range limits (yellow), or out-of-range (red). For the UPS to operate on utility
power, the voltage must be in the green range.

Volts Out. The Volts Out section on the right side of the screen shows the output voltage
of on the UPS with a colored bar. Colors have the same meaning as in the Volts In
section.

Use the Volts Out information and the % Load value to evaluate the utilization of your
UPS. If the % Load value is in the yellow or red range, your power requirements demand
a UPS with a higher load capacity. If the load value is in the red range, the UPS is
overloaded, and a computer shutdown will occur in one minute or less. If the load value is
in the green range, you are operating safely within the load range of the UPS.

To Select Input and Output Phases for Viewing

1. Choose Input Phase 1, Input Phase 2, or Input Phase 3 from the View menu.

2. Choose Output Phase 1, Output Phase 2, or Output Phase 3 from the View menu.
Input and output phase numbers need not be the same.



3. Choose either Data view or PowerScope from the View menu.
To Change Console Views

From the View menu, choose either Data or PowerScope.
To Select Another Node to Monitor (LanSafe III)

1. From the File menu, choose Select Node.

2. Select Rebuild List.

3. Select the node.

4. Choose Select Node.

Viewing the Logs
Your power management software provides a Power Log, a Battery Management Log,
and a Periodic Log for each node. On the Power Log and Battery Management Log,
significant events are arranged by date and time. On the Periodic Log, the flow of power
is displayed as a graph. You can export the Power Log and Battery Management Logs as
text to an ASCII file which you can print. Data from the periodic log is saved to an ASCII
file which a spreadsheet program can interpret. In LanSafe III, to clear logs other than
your own, you must have the UPS access code.

To Access a Log

From the Logs menu, choose View/Clear Power Event Log, View/Clear Battery
Management Log, or View/Clear Periodic Log.

To Enable the Periodic Log

1. From the Setup menu, choose Periodic Log Setup.

2. From the Periodic Log Setup dialog box, choose Enabled.
To Establish Periodic Log Settings

1. In the Periodic Log Setup dialog box, set a Sample Rate (in minutes), using the
Sample Rate (Minutes) spin field.

2. Set the number of days the file should be kept, using the Keep logs for (Days) spin
field.

3. Note in the “Logs will occupy” message that the required disk space varies with the
sample rate and with the number of days the log is to be kept.

System Control Features
Control features include setup, shutdown, and deleting the logs. Control is limited to your
local node. To control another network node running LanSafe III, you must enter the
proper access code at your computer.

To Select a LanSafe III Node to Control

1. Choose Select Node from the File menu to open the Select Node dialog box.

2. In the node lists, highlight the node you wish to control.

If you highlight a node in a UPS group, you must highlight the entire group. Use the
Domains/Networks list to change the lists of File Servers or Domain Controllers,
Other Servers or Hosts, and Workstations or Requesters. Choose Rebuild List to
refresh the list.

3. Click the Enter Access Code button and enter the LanSafe III access code for the
node you wish to control.



4. Choose Select Node.

5. The Console Node Information section shows the name and address of the node you
selected to control.

To Control a Node with Another LanSafe III Access Code

1. Choose Enter Access Code from the File menu to open the Enter Access Code
dialog box.

2. Enter the access code.

3. Select the node at the Select Node dialog box.
To Change the LanSafe III Access Code for a Node

1. Choose Access Code from the Setup menu to open the Configure UPS Access Code
dialog box.

2. Enter the new access code.

3. Verify the new access code.

This code change applies to the node whose name and address appear in the Node
Information section of your Console display.

To Change the LanSafe III Access Code for a Network

1. Choose Access Code for Network from the Setup menu to open the Configure UPS
Access Code for Network dialog box.

2. Use the Networks list to select the network or network segment to which the new
access code is to apply.

3. Enter the new access code.

4. Verify the new access code.
To Configure the Network UPS Access Code for a UPS Group

In LanSafe III, when you open the Configure Network UPS Access Code dialog box, the
list box shows UPS group members. The new access code applies to the group controller
and its members.

Diagnostics Tasks
Diagnostics consist of running a hardware test and preventive maintenance either for the
local node or the network. The procedures are the same. In addition, you can program
your power management software to put a maintenance reminder on your Power Monitor
window.

NOTE
UPSs with dry-contact interfaces do not support hardware tests or preventive
maintenance.

To Set Up a Maintenance Reminder

1. On the Setup menu, click Maintenance Schedule.

2. In the Maintenance Schedule Setup dialog box, click Enabled to set a schedule or
Disabled if you do not want a reminder to appear in the Power Log at set intervals.

3. If you choose Enabled, the Days Between Runs field become active. Use the arrow
keys to specify the interval (in days) between maintenance reminders. This may be
any number between 30 and 999 (the default is 90).



Reminders appear in the Power Monitor window.
To Test Hardware for the Selected Node

1. On the Maintenance menu, click Test Hardware.

2. On the Test Hardware dialog box, click Start.

The test places the UPS on battery for several seconds. During this time, the UPS verifies
the battery and internal circuit operation. It displays the current testing status.

To close the dialog box without starting a test, choose Exit. To close the Test Hardware
dialog box during a test, start the test and choose Exit. The test continues.

To Test Hardware for Network (LanSafe III)

1. On the Maintenance menu, click Test Hardware for Network.

2. On the Test Hardware for Network dialog box, use the Domains/Networks list and the
Domain Controllers/File Servers, Other Servers/Hosts, and Workstations/Requesters
check boxes to create a List of Power Monitor Nodes to Test.

3. Choose Start.

A message lets you know how much time has passed and when testing finishes.

To close the dialog box without testing, choose Exit. To close the Test Hardware dialog
box during a test, start the test and choose Exit. The test continues.

To Run Preventive Maintenance

Follow the procedure for a hardware test, choosing either Preventive Maintenance or
Preventive Maintenance for Network from the Maintenance menu.

Alert Response
The role of the UPS is to put your system on UPS battery power in the event of a power
emergency and to complete an orderly shutdown without loss of data. Depending on your
needs, you can configure the length of time the system remains on battery before shutting
down, with either maximum or minimum battery use. Using the Customize Alerts feature,
you can program the system to send alert messages to key personnel, even at remote
addresses.

To Reconfigure Shutdown Timing

1. On the Setup menu, click Shutdown Timing.

2. On the Shutdown Timings, Restart Delays and Load Segment Configuration dialog
box click an icon for a computer.

3. Enter values for wink time, power failure countdown time, and time needed to down
system.

Wink time eliminates nuisance messages from brief power interruptions. Choose any
integer between 1 and 999 (the default value is 5 seconds).

Power failure countdown time gives you time to finish your work and save your files. Each
minute, you are informed of the time remaining until shutdown. Choose any integer from 1
to 999 (the default value is 5 minutes).

Time needed to down system allows the Power Monitor to log off users, terminate any
applications that are still running, and close all files in the computer’s file system. The
time may be any integer from 1 to 999 .

If you configure a UPS group shutdown time you cannot set the shutdown time for the
UPS group controller at a value less than the shutdown time for any group member. To
reduce the shutdown time for the UPS group controller to a value less than the current



shutdown time for a group member, you must first reduce the shutdown time for the
member.

Things to Remember About Shutdown Timing

•  The length of battery protection increases as the load on the UPS decreases.

•  After a power outage, another outage could occur before the UPS batteries fully
charge. For complete system fault tolerance, set the countdown time at a value small
enough to allow battery reserve for at least two shutdowns.

•  It is extremely important that the UPS not shut off until all applications are terminated
and all files in the file system are closed. Set the time needed to down the system at a
value large enough to assure that the Power Monitor software has time to shut down
a worst-case computer environment.

Customizing Alerts
The Customize Alerts feature enables you to change the text for alert messages, and to
cause a particular alert to execute a command, send an e-mail message, send a string to
a modem, or to send a broadcast message to selected users. If supported, you can also
activate Netfinity alerts from the Customize Alerts dialog box.

In all cases, the basic procedure is as follows:

1. On the Setup menu, click Customize Alerts.

2. On the Customize Alerts dialog box, click one or more messages from the scroll list at
the left side of the box, or click Select All. If you select only one message, or if all
selected messages have the same text, a customizable message for a selected alert
appears in the Message Text list.

Follow the procedure for the customization you wish to make (see below).

To Change the Text for a Message

Enter a new message in the Message Text list, or translate the message to another
language.

To Execute a Command when an Alert Occurs

1. Put a check in the Execute Command box.

2. Click the Execute Command edit field.

3. Enter a fully qualified path name for the command and any parameters, using the
variables that appear in the Substitution Variables box.

If you selected multiple alerts and the alerts do not all execute the same command, the
check box and field are gray. To set multiple alerts to execute the same command, select
the alerts and complete this field. To change the action the system takes in an alert
situation, choose a message and type a new command in the Execute Command edit
field. If the command is a DOS executable or batch file, you must include the extension,
for example, EXECUTE.EXE for a DOS executable or FILE.BAT for a batch file. For help
in writing a DOS command or a batch file, see your DOS documentation or on-line help.
To test operation of this command in real time, choose the Test button.



To Send E-Mail

NOTE
LanSafe III supports e-mail sending by default with the MAPI protocol. Popular e-mail
applications such as MS Outlook Express, Lotus Notes, and Group Wise are MAPI
protocol compliant.
Optionally, if you need to use SMTP mail protocol for mail sending, you must enable
and configure the ls3smtp.txt file in the LanSafe installation directory, preferably with
the advice of your system administrator or internet service provider. Whether you use
MAPI or SMTP protocol, it is advisable that you test your setup before assuming it will
work.

Sending E-Mail (MAPI or SMTP Protocol)

1. On the Customize Alerts dialog box, select a message or multiple messages in the
message list that you want to send by e-mail when they occur.

2. Check the E-mail box.

3. In the text edit field for E-mail, type the e-mail addresses of the persons to whom you
want a message sent should the selected alert condition occur. Separate multiple
addresses by commas.

4. SMTP protocol systems only: Complete the “Configuring SMTP Protocol E-mail”
procedure below.

The e-mail recipient receives the message via the recipient’s mail system. Recipients
should be sure their systems are set up to receive e-mail from all potential senders. See
documentation for your specific e-mail systems for details.

To test operation of this command in real time, choose the Test button for E-Mail.
Configuring SMTP Protocol E-mail

Use the following procedure to set up LanSafe III e-mail with SMTP protocol.

In most cases, only Steps 1 through 4 are required.

1. Locate the ls3smtp.txt in your LanSafe III installation directory.

2. Open the ls3smtp.txt file for editing with an ASCII-compliant text editor.

3. Add a semi-colon in front of the word DISABLED to enable SMTP.

4. A) Remove the semi-colon at the beginning of the following line:
;address smtpserver.company-name.com

B) Replace smtpserver.company-name.com with the IP address or host name for
your SMTP port 25 server

Example: 1) address 191.66.55.001
2) address smtpserver

5. A) Remove the semi-colon at the beginning of the following line:
;helo LS3computer.company-name.com

B) Replace LS3computer.company-name.com with the name of the host sending the
command.

Example: 1) helo Lansafecomputer
2) helo ls3computer.company-name.com

6. A) Remove the semi-colon at the beginning of the following line



;from LanSafe@LS3computer.company-name.com

B) Replace LanSafe@LS3computer.company-name.com with the name of the sender
or sending computer system.

Example: 1) from LanSafe@LS3computer.company-name.com
2) from Lansafecomputer

7. Save your changes to ls3smtp.txt and reboot the computer for the new settings to
take effect.

NOTE. When a line starts with a semi-colon (;), all words on that line are considered
commented out and the system ignores them.

To Send a String to a Modem

1. Put a check in the Send String to Modem check box.

2. Specify the modem port by choosing Comm Port to open the Communications Port
dialog box.

3. Click the text field.

4. Using the variables that appear in the Substitution Variables box, enter a string to be
sent. See Creating a Modem String.

If you select multiple alerts, the check box and text field are blank unless all the alerts
send the same string to the modem.

To set multiple alerts to send the same string to the modem, select the alerts and enter
the string.

To test operation of this command in real time, choose the Test button.
Creating a modem string

Exact instructions for creating a modem string vary from carrier to carrier. However, the
following example, which assumes SkyPage and the Windows Terminal program, should
provide the essential details for you to create a modem string in a system other than
SkyPage and Windows, if necessary. After creating your modem string, be sure to test it.

NOTE
If your service does not handle alphanumeric messages, check with your service.

ATZ (Return & Wait)
OK
ATDT918007599673 (Return & Wait)
CARRIER 2400
PROTOCOL: LAP-M
COMPRESSION: NONE
CONNECT 2400/ARQ (Return & Wait)
SKYTEL REMOTE TERMINAL
PAGER ID: 3024258 (Return)
FUNCTION: (Return)
ENTER ALPHA MESSAGE: TEXT HERE (Return)
SEND ?: (Return)
FUNCTION: 99 (Return)
In this case the dialing string would be as follows:
ATZ$RET$WAIT$ATDT18007599673$RET$WAIT$RET$WAIT12345678$RET$TEXT
HERE$RET$RET99$RET

The following table shows definitions of the string and variables:
ATZ Soft reset modem and restore active profile 0*.

$ RET Carriage Return (Enter).

mailto:SanSafe@LS3computer.company-name.co
mailto:LanSafe@LS3computer.company-name.co
mailto:LanSafe3@spaghetti


$WAIT Wait for any string to return from other modem.

ATDT Dial in touch tone mode (Always followed by the phone
number with any necessary prefixes or suffixes). i.e.
918005551212. 9, to get an outside line, 1 for long
distance and 8005551212 is the area code and phone
number of the modem/service you wish to call.

TEXT HERE Pertinent text should be inputted exactly as you would
like it to display on the pager. You can use one of the wild
cards listed below to substitute from data collected from
the connected CPU.

$MSGNUM The actual number of the alarm from list or manual.

$MACHINE The name given to the CPU (Not by LanSafe III).

$MESSAGE Repeat the message string set up in the “Message Text”
window. Can change language and include variables
also.

$MINUTES Minutes remaining until shutdown.

*Modem Profile should be pre-configured for your service (bits, parity, stop bits,
and baud rate (that is, 8, none, 1, 2400).

To Set a Delay Time for an Alert Message

You can set a delay on particular messages in addition to the wink time set under
Shutdown Timing. If the situation is resolved before the combined wink time and delay
time expire, you are not interrupted.

1. Select a message.  If a delay time can be set for the message, the Delay Time
(seconds) edit field becomes active.

2. Select a delay time.

To Send Broadcast Messages to Logged-On Users

NOTE
This feature is not available in Windows 95.

1. Put a check in the Broadcast Message to Users check box.

2. Choose the users to receive broadcast messages, using the All radio button to send a
message to all users or the Some radio button to send a broadcast message to those
you specify in the list box. If you select multiple alerts, the check box is gray unless
the alerts send broadcast messages to the same users.

3. To set multiple alerts to send broadcast messages to the same users, select those
alerts and complete the information in this area. To test operation of this command in
real time, choose the Test button. Users who are not logged in at the time of the alert
do not receive a message.

To Send Netfinity Alerts

Place a check mark in the Send a Netfinity Alert check box.

Routine Shutdowns
Use LanSafe III to shut down all or part of your system at any time. If your UPS supports
load shedding, you can schedule shutdowns on a regular basis. Use to the Shutdown
menu to shut down the selected Power Monitor node, and unload the Power Monitor
program at the selected node. Use the Weekly Schedule option under the Shutdown
menu to schedule shutdowns and restarts at a set time.

To Unload the Power Monitor



Choose Unload Power Monitor from the Shutdown menu.

NOTE
Exercise extreme caution in using the Shutdown menu. If a server is shut down from
the Console, all users on the server are forcibly logged out, and work in progress may
be lost.

When a UPS group member chooses Unload Power Monitor from the Shutdown menu,
the UPS Group Unload dialog box opens. You can unload UPS group members, but if you
unload the UPS group controller you automatically unload the entire group.

To Shut Down and Reboot the System

1. Choose Shutdown/Reboot System from the Shutdown menu to open the
Shutdown/Reboot dialog box.

2. For an automatic reboot after shutdown, choose Reboot. If your UPS supports it,
choose Timed for a shutdown of a specific length, or choose Permanent for a system
shutdown until the UPS is restarted.

3. Choose Shutdown.

Choosing Timed activates the Time To Come Up spin field where you set a date and time
for the system to reboot.

To Shut Down a Load Segment on a Scheduled Basis

Only UPSs supporting load shedding support this feature.

1. Choose Weekly Schedule from the Shutdown menu.
The Weekly Schedule dialog box opens.

2. Highlight a load segment.

3. Use the Weekday scroll field to designate the day of the week to which the schedule
is to apply.

4. Use the Goes Off At scroll field to designate the time power to the load segment is to
turn off.

5. Use the Goes On At scroll field to designate the time power to the load segment is to
turn on.

Load Shedding
If your UPS supports load shedding, you can divide your load into segments with various
shutdown or restart delays. At the start of an emergency, load shedding is used to shut
down non-essential equipment so there is more battery power for the essential
equipment. It is used at startup to bring essential servers or other equipment on line
before non-essential equipment is started.

To Configure Load Segments

1. Attach your computer and peripherals to the numbered load segment receptacle
groups on the rear of your UPS.

2. Choose Load Segment Configuration from the Setup Menu. The Shutdown Timings,
Restart Delays and Load Segment Configuration dialog box opens.

4. Drag and drop the icon for your computer to the icon for the Load Segment to which it
is physically attached.

Your non-essential peripherals should be physically attached to the other Load Segment
on back of the UPS.



To Shorten a Shutdown Delay

NOTE
Before setting a shutdown delay, you must configure your load segments. See the
Load Segment Configuration procedure.

1. In the Shutdown Timings, Restart Delays and Load Segment Configuration dialog
box, choose the Load Segment for the devices other than your computer.

2. Set a Power Failure Run Time, using the Power Failure Run Time scroll list.
To Delay Restart of a Load Segment

1. In the Shutdown Timings, Restart Delays and Load Segment Configuration dialog
box, choose the Load Segment for the devices other than your computer.

2. Set a Restart Delay, using the Restart Delay [seconds] scroll list.

NOTE
You can also set this delay by using the Restart Delay dialog box. Choose Restart
Delay from the Setup menu.

To Set a Restart Delay

This feature is supported only by certain UPSs. See your UPS manual for details.

Specify a restart delay for any load segment with equipment you do not need immediately
upon reboot. Servers or your computer can be left with a zero restart delay (the default),
while workstations or peripherals can be programmed with a later restart delay.

To Delay Restart of Non-Essential Peripherals

1. Choose Restart Delay from the Setup menu. The Shutdown Timings, Restart Delays
and Load Segment Configuration dialog box opens.

2. Select the Load Segment to which your computer is attached.

3. Set a restart delay, using the Restart Delay [seconds] scroll list.

Accessing the Help System
To access online help from any dialog box, press F1. To access the complete online help
program, choose General Usage from the Help menu.

To Check the Software Version

Choose About from the Help menu to open the About dialog box.

Alternate Console Startup Methods
For alternate methods for running the LanSafe III Console, see below.

To Monitor LanSafe III on Another Node

Do one of the following:

•  Start the Console, and select the node using the Select Node dialog box.

•  In the directory with your LanSafe III files, start LS3CON NodeName.
To Control LanSafe III on Another Node

Do one of the following:



•  Start the Console, choose Enter Access Code from the File menu, enter the other
LanSafe III access code, and select the node using the Select Node dialog box.

•  In the directory with your LanSafe III files, start LS3CON /A=AccessCode NodeName.
To Control a Node in a Group Whose Access Codes Differ from Yours

Do one of the following:

•  Start the Console, enter the access code, and select the desired node using the
Select Node dialog box.

•  In the directory with your LanSafe III files, start LS3CON /A=AccessCode.
To Limit Your Build to Speed Network Polling

1. Create a text file in the directory where your LanSafe III files are stored listing one
network segment per line.
To add a comment to a line, type # and your text. The system will not read it.

2. In the directory where your LanSafe III files are stored, start
LS3CON/Networks=MYNETS.TXT.

Rather than poll the entire network, LanSafe III polls only the network segments on your
list.

If you do not enter a command line parameter, the Console attempts to read a file named
NETWORKS.TXT in the LanSafe III directory. If this file does not exist, the entire network
is polled.



UNIX Text-Based Environment Operation
You can run LanSafe III for UNIX in a text-based environment. This requires that you start
the Power Monitor daemon, but there is no Power Monitor window for system messages.
Messages appear on the screen as broadcast messages. Console operation is from a
main menu. Options appear on the terminal screen as text prompts.

You can monitor and control all functions for your own node. You can monitor all nodes in
your network. To control them, you must have the access code.

Before you begin, be sure the daemon (ls3) is running.

To Start the LanSafe III Console for Your Own Node

Assuming the default installation path, type /usr/ls3/ls3con
To Start LanSafe III and Select a Node to View or Control

Type /usr/ls3/ls3con [-a accesscode] [hostname]

...where [hostname] and [-a accesscode] apply to the node you wish to view or
control.

If you do not know the access code, press <Enter> to bring up a version of the Console in
which only options 1 and 5 are active, allowing you to monitor but not control the node.

Options 1 through 4 of the Console Main Menu are disabled if the wrong access code is
entered. Individual features are disabled if the UPS does not support them.

Configuring LanSafe III

Choose 1 from the Main Menu to open the Configure LanSafe menu.
To Close the Screen and Return to the Main Menu

1. Type 0.

2. Type y to save or n to discard any configuration changes.
To Enter a New Communications Port

1. Type 1.

2. Type the device name.

For a list of device names, see section 2, Installation.
To Configure Shutdown Timing

1. Type 2.

2. Enter values for wink time, power failure countdown time, and time needed to down
system.

See section 3, Operation, for an explanation of these values.
To Schedule Maintenance

Type 3 and enter the number of days between maintenance reminders. The reminders
appear in the Power Monitor window and the Power Log each day until you run preventive
maintenance.

To Change the Access Code

[This applies to the node whose hostname and address appear on the Main Menu.]

1. Type 4.

2. Enter the new access code.



3. Reenter it.

4. When the “Are You Sure?” prompt appears, type y to confirm or n to abort the code
change.

To Save any Setting Changes You Have Made

Type 5.
To Cancel any Changes and Restore the Defaults

Type 6.

Use this option to return the system to the defaults even after you have made changes
and saved and entered them.

Running a Hardware Test or Preventive Maintenance

1. From the Main menu, choose 1 to run a hardware test or 3 to run preventive
maintenance.

2. Refer to the Console Data View Operational Status display.

3. If a problem is found, a message appears.
Shutting Down or Rebooting the Workstation

1. From the Main menu, choose 4 to open a list of shutdown/reboot options.

2. Type 1 for a long shutdown, 2 for a short shutdown, 3 for a permanent shutdown, 4 to
shut down the LanSafe III daemon and terminate LanSafe III power protection, or 0 to
close the screen and return to the Main menu.

If you are considering a long or a short shutdown, see your UPS documentation to
determine if the unit supports shut downs of varying lengths. If you choose a permanent
shutdown, restart your system in accordance with your UPS documentation.

Monitoring a Power Environment

From the Main menu, choose 5 to open a list of UPS values for utility and battery power.

Contents of this list vary according to UPS model.

Backup Time is the number of minutes the UPS is capable of supporting your system as
presently configured.

To Update the List, or to Close It

1. Press any key and <Enter>.

2. Type 1 to update the listed values or 0 to close the list.
Exporting Log Files

1. From the Main menu, choose 6 to open a list of log export options.

2. Type 1 to export the Power Log or 2 to export the Battery log.



Troubleshooting
If your power management software fails to perform as it should, here is a list of things to
check:

• Be sure that communication between the UPS and your computer is correctly set up
and configured.

o Be sure you are using the correct communications cable. If a cable was included
with the UPS, use that cable only. If a cable was not included with the UPS, use
the cable that came with your software.

o Be sure the computer communications port used is a dedicated port.

o Be sure the computer communications port is the one chosen in the
Communications Setup dialog box.

o Test your communications port: Remove the communication cable and replace it
with your mouse. If you cannot move your cursor, the port is inoperative.

• For Windows NT and Novell environments, be sure you are running LanSafe III in a
computer network, not a standalone computer.

• If you are running LanSafe III in a network, be sure you have logged on to your
network in accordance with the correct procedures.

• Review the system requirements for file servers and workstations in Section 2,
Installation.

• Review the lists in Things to Remember About Running the Software, and Things To
Remember When Running LanSafe III in a UPS Group in Section 3, Operations.

• See Table A-1.

To reinstall, see Section 2, Installation.

Table A-1
Troubleshooting (Novell, Microsoft, OS/2 Platforms)

Problem Possible Cause Solution

Message: Must log on to server with
SUPERVISOR rights

You are not logged into a file server Log on, using account with
SUPERVISOR rights

Account you logged onto lacks
SUPERVISOR rights

Log on, using account with
SUPERVISOR rights

I do not see file server You are not logged on to or attached
to file server

Log on or attach to server using
account with SUPERVISOR rights

I want to install on list displayed by
LanSafe III

The account you are logged on or
attached to does not have
SUPERVISOR rights

Log in or attached to server you want
to install, using account with
SUPERVISOR rights

Message: Configuration file error Installation unsuccessful Reinstall

User installed for LanSafe III lacks
SUPERVISOR rights

Assign SUPERVISOR rights to user

Installation successful, but Console
cannot see node

Power Monitor not loaded after
installation

Start Power Monitor

Message: Unable to Contact Power
Monitor

Software not running Start Power Monitor

Message: Cannot contact UPS Group
Controller

Group Controller not running LanSafe
III

Start LanSafe III on Group Controller
node

Message: Comm port unavailable Another hardware device is configured Reconfigure LanSafe III and



with same IRQ or I/O address as
LanSafe III

communication port hardware with
different addresses

Communications error message; or
power failure or low battery messages
despite no apparent failure; or, no
messages when power failure is
simulated

LanSafe III and cables configured on
different communication ports

Reconfigure communications port

Interface cable not connected, secure,
or properly installed

See UPS Hardware installation
manual

Troubleshooting UNIX systems
Problem: Message when I try to tar off the tape or diskette: Device not found or unable to

open device
Solution: Check system documentation for correct device identification.

Problem: Message: Cannot find install.ls3
Solution: 1. Part of installation failed.

2. Check disk space and root permissions.

Problem: Message during install: Files cannot be found
Solution: Tar tape or diskette again and rerun install.sh

Problem: Message when installation is completed: Power Failure
Solution: Cable connected to wrong serial port.

Cable not connected to UPS.
Wrong cable type entered.

Problem: Some nodes do not appear in Select Power Monitor Node dialog box.
Solution: Power Monitors must be running on these nodes.

Nodes must be reachable from the local node. To verify, use ping.
Mapping for ls3 port must be the same on all machines. If NIS, NIS+, Yellow
Pages, or some other network mapping service is running, then the services map
must have entries for ls3.
For example:

ls3 3069/tcp
ls3 3069/udp

Otherwise the file /etc/services must contain the port mapping for ls3.
For example:

ls3 3069/tcp
ls3 3069/udp

The installation script modifies /etc/services. By default, the installation script tries
to use port 3069, but if this port is being used the installation script chooses
another. To make the change to /etc/services visible in an NIS environment, log
on to the node acting as the NIS master, add the LS3 port mapping to the local
/etc/services, and execute:

cd/var/yp
make

Problem: The Power Monitor does not start when system is booted but running ls3. works.
Solution: LanSafe III may be installed on an NFS file system. During system boot the

directory containing LanSafe III is not yet mounted. Move S891s3.init from
/etc/rc2.d to /etc/rc3.d.

Problem: System alternates between “On backup power” and “Power Restored”.
Solution: LanSafe shares serial port with another process, most likely a getty process.

Connect UPS to another port and reconfigure LanSafe, or terminate the getty.

Problem: Intermittent serial I/O error.
Solution: Be sure that only one LanSafe III daemon process is running and that no other

process is using the same serial device.



Problem: Power removed from UPS but no message.
Solution: Be sure the LanSafe III daemon process is running (ls3).

Be sure the cable is connected to the UPS.
Be sure the cable is connected to the correct serial port.

Problem: UPS reports serial I/O error.
Solution: Be sure the interface cable is properly installed and secure.

Verify that the Console is set to use the port to which the cable is connected.

Problem: “Cannot write to port” message.
Solution: Be sure root has read/write privileges on the port.

Be sure that only one LanSafe III daemon process is running and that no other
process is using the same serial device.

Problem: “Cannot connect to daemon” message.
Solution: Be sure the ls3 daemon is running. If not, start the daemon from the command

line via /usr/ls3/ls3 (assuming it is installed in the default directory).



Glossary
This glossary defines terms and other technical terms as used in power management. For
definitions of more general terms, see a standard computer reference.

ABM. The abbreviation for Advanced Battery Management, and a trademark of
Powerware Corporation. ABM is a proprietary, microprocessor-based, state-of-the-art
system for monitoring and managing UPS batteries, with such features as quick
recharging, doubled battery service life, and up to 60 days of early warning before your
batteries need replacement. ABM prevents overcharging and accelerated battery aging by
not constantly charging the battery.

Access Code. A means of facilitating the use of LanSafe III software, and of preventing
unauthorized shutdowns and disabling.

Battery Management Log. A record of ABM or Battery status whenever the ABM or
battery changes state. Records include log started, charging, discharging, floating
(meaning battery is receiving only a nominal charge), log stopped, and log cleared. ABM
systems include a “resting” message when the battery is receiving no charge. This ABM
feature reduces battery wear.

Blackout. A complete loss of utility power to the UPS.

Boost and Buck. A proprietary line regulation process used when an overvoltage or
undervoltage situation occurs in the UPS. Undervoltage is boosted to make it greater and
overvoltage is bucked to reduce it, thus reducing reliance on the battery.

Brownout. A condition where the utility power voltage drops below the lower limit of the
UPS, causing a switch to battery power via the inverter.

Bypass Circuitry. A feature of some UPSs which causes your system load to be
powered directly from the UPS input. See your hardware manual for details.

Charger. See Rectifier/Charger.

Console. Your primary interface with the UPS through the software. It allows you to view
and control the power environment of every node where the Power Monitor is running.

Data view. A Console display of colored bar graphs and text to give you a concise but
comprehensive overview of the UPS hardware and the utility power situation. Values are
updated at various intervals of less than 30 seconds to reflect a current picture of the
environment. See PowerScope.

Domain. In Windows NT, a group of computers with its own name, database, and
security policy. The computers are classified as the domain controller, other servers
(when used), and workstations.

Domain Controller. In Windows NT, the server that maintains the domain’s security
policy and master database, and authenticates domain logons. Domain controllers run
Windows NT Advanced Server. A domain may include other servers which receive copies
of the domain’s security policy and databases.

Emergency Shutdown. An automatic feature in the event of a UPS low battery or
overload condition. The Power Monitor begins to shut down applications and files.
Shutdown time is UPS-specified and depends on your UPS. Refer to your UPS manual.
See also Orderly Shutdown.

Filters. The UPS components that prevent corruption of system data by helping to ensure
that transients and high frequency noise are reduced or eliminated.

Hardware Test. Places the UPS on battery power for several seconds to verify proper
operation of the hardware.



Inverter. The UPS component that converts DC from your UPS battery to AC for
powering your system.

Load Shedding. A UPS feature enabling users to remove connected devices from the
load. Load shedding extends the power of your UPS battery.

Other Server. In Windows NT and Lan Server, the computer that receives a copy of the
domain’s security policy and domain databases, and authenticates network logons. Other
servers are distinguished from the domain controller which maintains the domain’s
security policy and master database. Other servers run Windows NT Advanced Server.

Orderly Shutdown. The power management software process, activated after a utility
power failure, which protects users and file systems from lost or corrupted data. Power
management software saves work in progress and shuts down your system in
accordance with the shutdown timing you set.

% Load. A percentage of the UPS’s calculated full load capacity.

Power Failure Countdown Time. The time in minutes after the end of wink time that the
software waits before starting a shutdown sequence. Use this time to save your work and
log out before your computer goes down.

Power Failure Run Time. The amount of time in minutes the devices of a load segment
will remain on during a power failure. For a load segment with a computer, the power
failure run time displays as AUTO and is the sum of the wink time, the power failure
countdown time, and the time needed to down system set in the Shutdown Timings,
Restart Delays and Load Segment Configuration dialog box. For a load segment with
dumb devices only, the power failure run time displays as INFINITE and can be set for
any duration from 1 min. to 999 min.

Power Log (Power Event Log). A record of significant power events, including power
outages, low battery and overload indications, hardware self-test results, software loads
and unloads, serial communication connections and failures, and preventive maintenance
reminders.

Power Monitor. The software component that communicates with your UPS to monitor
the status of the input utility power, output load and condition of the UPS hardware. The
Power Monitor also watches the power environment and provides alert processing,
orderly shutdown, and logging functions.

In Windows NT, the Power Monitor consists of a Windows NT system service and
window. The system service communicates with your UPS and provides alert processing,
orderly shutdown of your file system, and logging functions. In the event of a utility power
failure or other significant power event, the icon for the window appears on top of your
currently active window and beeps until you open it. If a shutdown is necessary, the
window shuts down your applications.

PowerScope. A system diagram with a full color display of your power. It is a View menu
option. Values are updated at various intervals of less than 30 seconds to reflect a current
picture of the power environment.

Preventive Maintenance. A procedure by which the UPS is placed on battery power for
several seconds to verify proper operation of your hardware. If your UPS does not support
preventive maintenance, a hardware test is run.

Rectifier/Charger. In some UPSs, a rectifier converts AC to DC. In others, a charger
which includes a rectifier converts AC to DC.

Requester. A computer running OS/2. See Workstation.

Restart Delay. A control of the Shutdown Timings, Restart Delays and Load Segment
Configuration dialog box used to bring up a server before workstations, or to bring up



peripherals after a workstation or workstations have been brought up. When the restart
delay for a load segment is 0 (the default) and the system is rebooted, the load segment
starts immediately. Restart delays can be set for up to up to 16,383 sec. (4 hr., 33 min.).

Run time. Maximum battery time available to support your system until inverter
shutdown, based on current load and UPS conditions.

Surge Condition. A situation in which utility power voltage exceeds the upper limit of the
UPS, causing a switch to battery power.

Time Needed to Down System. The time in seconds from when the software begins to
shut down your system until the power from the UPS shuts off.

UPS. Uninterruptible power system.

UPS Group—Group Controller—Group Members. When one UPS supports more than
one computer (either servers or workstations), the configuration is called a UPS group.
The one computer in the UPS group that is physically attached to the UPS
communications cable is called the UPS group controller. All other computers powered by
the UPS are called group members.

Wink. A brief interruption of utility power caused either by a blackout, a brownout, or a
surge condition.

Wink Time. The number of seconds after a utility power failure that the software waits to
inform you that the system will be shutting down. This delay eliminates nuisance
messages from brief power interruptions.

Workstation. A computer running Windows 95/98, Windows NT or OS/2. In Windows
NT, the domain controller and other servers run Windows NT Advanced Server. See
Requester.


	LanSafe III for Data Protection
	LanSafe III Installation Guide
	System Requirements
	Installing LanSafe III for OS/2
	Installing LanSafe III for Windows NT (Alpha)
	Installing LanSafe III for Windows 95/98 (Intel) (English)
	Installing LanSafe III for Windows 95/98 (Intel) (Japanese)
	Installing LanSafe III for Windows NT (Intel) (English)
	Installing LanSafe III for Windows NT (Intel) (Japanese)
	Installing LanSafe III for NetWare Servers
	Installing LanSafe III for UNIX (IBM AIX/RISC)
	Installing LanSafe III for UNIX (IBM AIX/PowerPC)
	Installing LanSafe III for UNIX (Digital UNIX)
	Installing LanSafe III for UNIX (Data General)
	Installing LanSafe III for UNIX (HP-UX 10 and 11)
	Installing LanSafe III for UNIX (Interactive)
	Installing LanSafe III for UNIX (IRIX)
	Installing LanSafe III for UNIX (Linux)
	Installing LanSafe III for UNIX (SCO Open Server)
	Installing LanSafe III for UNIX (Solaris)
	Installing LanSafe III for UNIX (AT&T SVR4)
	Installing LanSafe III for UNIX (UnixWare 7)
	SurfSafe
	Installing LanSafe III for SCO, Interactive, or UnixWare with Dry-Contact UPSs
	Testing the Software
	Removing LanSafe III for UNIX
	Starting the Power Monitor

	Operation
	Understanding UPS Groups
	Communications Setup
	Monitoring a Power Environment
	Viewing the Logs
	System Control Features
	Diagnostics Tasks
	Alert Response
	Customizing Alerts
	Routine Shutdowns
	Load Shedding
	Accessing the Help System
	Alternate Console Startup Methods
	UNIX Text-Based Environment Operation

	Troubleshooting
	Troubleshooting UNIX systems

	Glossary

